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1. Uvod u mikroservisne aplikacije 

Tema ovih časova je upoznavanje studenata sa planom kursa i obavezama na kursu, kao i razvijanje jednostavnog 

mikroservisa sa MongoDB SUBP. 

1. O kursu 

• Sajt kursa: http://rs2.matf.bg.ac.rs/   

• Prezentacija: http://rs2.matf.bg.ac.rs/vezbe/o-kursu.pdf  

• O seminarskim radovima: http://rs2.matf.bg.ac.rs/seminarski-radovi/  

• Neophodni alati: 

o Visual Studio (Windows), Visual Studio for Mac (OSX), Visual Studio Code (Windows, OSX, Linux), 

Jetbrains Rider (Windows, OSX, Linux) 

o .NET 5 (Windows, OSX, Linux) 

o Docker Desktop (Windows, OSX), Docker Server (Linux)  

2. O mikroservisnim aplikacijama 

• Ukratko proći kroz tekst: http://rs2.matf.bg.ac.rs/vezbe/ukratko-o-mikroservisima.pdf  

3. Razvoj Catalog.API mikroservisa 

• Priprema MongoDB kontejnera 

• Kreiranje projekta i instalacija paketa 

• Razvoj mikroservisa 

• Pokretanje i debagiranje aplikacije 

Priprema MongoDB kontejnera 

Na stranici https://hub.docker.com/ uneti „mongo“ u polje za pretragu. Otvoriti sledeću stranicu: 

 

Osnovni MongoDB pojmovi: baza dokumenata, dokumenti, jedinstveni ključevi (_id), kolekcije, indeksi (nad _id).  

Pokretanje mongo kontejnera: 

• Otvoriti Powershell 

• docker run --name mongo_catalog -p 27017:27017 -d mongo 

Ove naredbe ispisuju identifikator kontejnera u kojem je pokrenut MongoDB SUBP. Korisne docker naredbe:  

• Ispisuje sve pokrenute kontejnere 

o docker ps 

• Ispisuje sve kontejnere 

o docker ps -a 

http://rs2.matf.bg.ac.rs/
http://rs2.matf.bg.ac.rs/vezbe/o-kursu.pdf
http://rs2.matf.bg.ac.rs/seminarski-radovi/
http://rs2.matf.bg.ac.rs/vezbe/ukratko-o-mikroservisima.pdf
https://hub.docker.com/
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• Ispisuje samo identifikatore pokrenutih kontejnera 

o docker ps -q 

• Pokreće ugašeni kontejner 

o docker start IDENTIFIKATOR_KONTEJNERA 

• Zaustavlja pokrenuti kontejner 

o docker stop IDENTIFIKATOR_KONTEJNERA 

• Uklanja kontejner 

o docker rm IDENTIFIKATOR_KONTEJNERA 

• Uklanja sve kontejnere sa sistema 

o docker rm $(docker ps -aq) 

• Kreira novi kontejner na osnovu slike čiji je naziv IME_SLIKE na hub.docker.com i pokreće ga 

o docker run IME_SLIKE 

• Kreira novi kontejner na osnovu slike i pokreće ga, pri čemu mu daje ime IME_KONTEJNERA 

o docker run --name IME_KONTEJNERA IME_SLIKE 

• Kreira novi kontejner na osnovu slike i pokreće ga, pri čemu se vrši preslikavanje portova, tako što se 

UNUTRAŠNJI_PORT preslikava na SPOLJNI_PORT u localhost-u 

o docker run -p SPOLJNI_PORT:UNUTRAŠNJI_PORT IME_SLIKE 

• Kreira novi kontejner na osnovu slike i pokreće ga,  ali u pozadini (terminal se ne blokira) 

o docker run -d IME_SLIKE 

• Čita (i prati, ako se navede opcija -f) sve logove za pokrenuti kontejner 

o docker logs -f IME_KONTEJNERA 

• Pokreće interaktivni terminal u kontejneru. Ovo je korisno za izvršavanje proizvoljnih naredba  

o docker exec -it IME_KONTEJNERA /bin/bash 

Kada se prikačimo za mongo kontejner, dostupan nam je CLI alat mongo kojim možemo izvršavati proizvoljne 

naredbe za upravljanje mongo bazom. Neke osnovne komande ovog alata su: 

• Prikazuje sve baze podataka 

o show dbs 

• Bira bazu podataka BAZA_PODATAKA za koju će se odnositi sve dalje naredbe (odabrana BP biće dostupna 

kroz objekat db) 

o use BAZA_PODATAKA 

• Čitanje svih dokumenata iz kolekcije IME_KOLEKCIJE 

o db.IME_KOLEKCIJE.find({}) 

• Unošenje novog dokumenta u kolekciju IME_KOLEKCIJE 

o db.IME_KOLEKCIJE.insertOne({ name: ’Pera’, prezime: ’Perić’ })  

• Ažuriranje 

o db.IME_KOLEKCIJE.updateOne({ name: ’Pera’ }, { $set: { izmenjen: true } }) 

• Brisanje 

o db.IME_KOLEKCIJE.deleteOne({ name: ’Pera’ }) 

Kreiranje projekta i  instaliranje paketa 

S obzirom da započinjemo razvoj „od nule“, potrebno je prvo da napravimo jedan Solution pre nego što kreiramo 

bilo koji projekat: 

• File > New > Project 

• Blank Solution 

• Popuniti neophodnim podacima: 

o Solution name: Webstore 

o Location: LOKACIJA_LOKALNOG_REPOZITORIJUMA 

o Solution: Create new solution 
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• Create 

Sada možemo da kreiramo nove projekte: 

• Desni klik na ime Solution-a 

• Add > New Project 

• ASP.NET Core Web API 

• Popuniti neophodnim podacima: 

o Project name: Catalog.API 

o Location: LOKACIJA_LOKALNOG_REPOZITORIJUMA\Services\Catalog 

• Next 

• Odabrati opcije kao na slici pored: 

• Create 

Pre nego što krenemo sa razvojem, potrebno je da instaliramo 

neophodne pakete. Otvoriti NuGet Package Manager 

sledećim koracima: 

• Desni klik na naziv projekta 

• Manage NuGet Packages 

Prvo ćemo ažurirati sve pakete koji su do sada instalirani: 

• Updates 

• Select all packages 

• Update 

Zatim je potrebno otvoriti tab „Browse“ i tu pronaći i instalirati sledeće pakete:  

• MongoDB.Driver 

Razvoj mikroservisa 

API mikroservisa je opisan slikom pored. 

Prvo podešavamo opcije za pokretanje aplikacije: 

• Desni klik na naziv projekta 

• Properties 

• Debug 

• Podesiti opcije sa slike ispod.  
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Zatim prelazimo na kodiranje, prema narednom redosledu: 

• Entities 

o Product.cs 

• Data 

o ICatalogContext.cs 

o CatalogContext.cs 

o CatalogContextSeed.cs 

• Repositories 

o IProductRepository.cs 

o ProductRepository.cs 

• Controllers 

o CatalogController.cs 

Sada je preostalo da dodamo ubrizgavanje zavisnosti, što se nalazi u Startup.cs datoteci. 

Pokretanje i debagiranje aplikacije 

Iz gornjeg menija odabrati naredne opcije i pokrenuti aplikaciju: 

 

Postaviti u nekom zahtevu tačku prekida i prolaziti kroz kod. Prikazivati Visual Studio okruženje za debagiranje.  
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2. Višestruki mikroservisi. Kontejnerizacija aplikacije. 

Tema ovih časova je rad sa Redis, distrubuiranom keš memorijom i kontejnerizacija projekata pomoću Docker i 

Docker Compose alata. 

1. Razvoj Basket.API mikroservisa 

Priprema Redis kontejnera 

Na stranici https://hub.docker.com/ uneti „redis“ u polje za pretragu. Otvoriti sledeću stranicu: 

 

Osnovni Redis pojmovi: baza ključ-vrednost, keš memorija, prednosti i ograničenja (https://redis.io/topics/faq). 

Pokretanje redis kontejnera: 

• Otvoriti Powershell 

• docker run -d -p 6379:6379 --name redis_basket redis 

Kada se prikačimo za redis kontejner, dostupan nam je alat redis-cli kojim možemo izvršavati proizvoljne naredbe za 

upravljanje redis bazom. Neke osnovne komande ovog alata su: 

• Provera da li je baza spremna (očekuje se odgovor PONG) 

o ping 

• Postavljanje vrednosti 

o set KLJUČ VREDNOST 

• Čitanje vrednosti 

o get KLJUČ 

Kreiranje projekta i  instaliranje paketa 

Dodajemo novi projekat u okviru već napravljenog Solution-a: 

• Desni klik na ime Solution-a 

• Add > New Project 

• ASP.NET Core Web API 

• Popuniti neophodnim podacima: 

o Project name: Basket.API 

o Location:  

LOKACIJA_LOKALNOG_REPOZITORIJUMA\ 

Services\Basket 

• Next 

• Odabrati opcije kao na slici pored. 

• Create 

Pre nego što krenemo sa razvojem, potrebno je da instaliramo neophodne pakete. Otvoriti NuGet Package Manager 

sledećim koracima: 

https://hub.docker.com/
https://redis.io/topics/faq
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• Desni klik na naziv projekta 

• Manage NuGet Packages 

Prvo ćemo ažurirati sve pakete koji su do sada instalirani: 

• Updates 

• Select all packages 

• Update 

Zatim je potrebno otvoriti tab „Browse“ i tu pronaći i instalirati sledeće pakete:  

• Newtonsoft.Json 

• Microsoft.Extensions.Caching.StackExchangeRedis 

Razvoj mikroservisa 

API mikroservisa je opisan slikom pored. 

Prvo podešavamo opcije za pokretanje aplikacije:  

• Desni klik na naziv projekta 

• Properties 

• Debug 

• Podesiti opcije sa slike ispod. 

 

Zatim prelazimo na kodiranje, prema narednom redosledu: 

• Entities 

o ShoppingCartItem.cs 

o ShoppingCart.cs 

• Repositories 

o IBasketRepository.cs 

o BasketRepository.cs 

• Controllers 

o BasketController.cs 

Sada je preostalo da dodamo ubrizgavanje zavisnosti, što se nalazi u Startup.cs datoteci. 
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Pokretanje i debagiranje aplikacije 

Iz gornjeg menija odabrati naredne opcije i pokrenuti aplikaciju: 

 

2. Kontejnerizacija projekata 

Pre nego što bilo šta uradimo, preporuka je da 

postavimo naredne opcije u Visual Studio alatu, kako 

bismo izbegli neka suvišna pokretanja Docker 

Compose alata: 

• Tools > Options 

• Otvoriti Container Tools grupu opcija 

• Odabrati opciju Docker Compose 

• Odabrati opcije sa naredne slike: 

 

Dodavanje podrške za Docker Compose projektu: 

• Desni klik na naziv projekta 

• Add > Container Orchestrator Support 

• Docker Compose 

• Ok 

• Linux 

• Ok 

Proći kroz generisani Dockerfile i objasniti neke najvažnije elemente, a zatim objasniti docker-compose.yml i docker-

compose.override.yml datoteke. 

Dodati naredne resurse u docker-compose.yml datoteku: 

services: 

  catalogdb: 

    image: mongo 

  basketdb: 

    image: redis:alpine 

 

volumes: 

  mongo_data: 

 

Dodati naredne resurse u docker-compose.override.yml datoteku: 

services: 

  catalogdb: 

    container_name: catalogdb 

    restart: always 

    ports: 

      - "27017:27017" 

    volumes: 

      - mongo_data:/data/db 
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  basketdb: 

    container_name: basketdb 

    restart: always 

    ports: 

      - "6379:6379" 

 

  catalog.api: 

    container_name: catalog.api 

    environment: 

      - ASPNETCORE_ENVIRONMENT=Development 

      - "DatabaseSettings:ConnectionString=mongodb://catalogdb:27017" 

    depends_on: 

      - catalogdb 

    ports: 

      - "8000:80" 

 

  basket.api: 

    container_name: basket.api 

    environment: 

      - ASPNETCORE_ENVIRONMENT=Development 

      - "CacheSettings:ConnectionString=basketdb:6379" 

    depends_on: 

      - basketdb 

    ports: 

      - "8001:80" 

 

Pokretanje projekta iz komandne linije 

Pokretanje kontejnera iz komandne linije se vrši alatom docker-compose koja ima nekoliko važnih komandi (opcija -d 

označava da će se proces nastaviti u pozadini, kako se ne bi blokirao terminal) : 

• Izgradnja svih kontejnera 

o docker-compose build 

• Podizanje svih kontejnera 

o docker-compose up -d 

• Izgradnja i podizanje svih kontejnera 

o docker-compose up --build -d 

• Zaustavljanje svih kontejnera 

o docker-compose stop 

• Zaustavljanje i uklanjanje svih kontejnera 

o docker-compose down 

• Specifikovanje datoteka koje se koriste za podizanje/spuštanje svih kontejnera 

o docker-compose -f docker-compose.yml -f docker-compose.override.yml up --build -d 

o docker-compose -f docker-compose.yml -f docker-compose.override.yml 

Debagiranje projekata u kontejneru 

Kako bismo omogućili debagiranje projekata koji se pokreću u kontejneru, potrebno je da ručno zakačimo debager 

za proces koji se izvršava u kontejneru. Pre toga, potrebno je isključiti opciju „Enable Just My Code“ u 

podešavanjima, kako bismo instruisali Visual Studio da debagira i kod koji je izgrađen u kontejnerima: 

• Tools > Options 

• Debugging > General 
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• Isključiti opciju „Enable Just My Code“, kao na slici ispod 

 

Sada možemo zakačiti debager: 

• Debug > Attach to Process 

• Za „Connection type“ odabrati Docker (Linux Container) 

• Odabrati dugme Find 

• Nakon nekoliko sekundi bi trebalo da se pojavi spisak svih podignutih kontejnera. Odabrati, na primer, 

basket.api projekat, pa dugme Ok 

• U tabeli „Available processes“ bi trebalo da se pojavi „dotnet“ proces , kao na slici ispod 

• Odabrati taj proces, pa dugme Attach 

• Odabrati opciju „Managed (.NET Core for Unix)“, pa dugme Ok  

• Posle nekoliko sekundi, debager će biti zakačen za proces 

 

Pokretanje projekta iz Visual Studio alata 

Nakon što smo napravili docker-compose projekat, potrebno je da odaberemo naredne opcije u glavnom meniju: 
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Klikom na pokretanje se vrše naredne akcije: 

• Izgrađuje se kod iz Solution-a 

• Izgrađuju se kontejneri 

• Pokreću se kontejneri 

• Pokreće se debager i automatski se zakači za izvršni kod 

Neke napomene 

• Prednosti korišćenja su automatsko podizanje i automatsko debagiranje.  

• Gašenjem projekta (bilo iz Visual Studio alata, gašenjem pregledača ili gašenjem terminala) se ne gase  

kontejneri, ali se ne mogu ugasiti iz Docker Desktopa, pa je neophodno uraditi Build > Clean solution iz 

glavnog menija – obavezno pre zatvaranja Visual Studio alata.  

• Treba imati u vidu da će se konfiguracija prvo pročitati iz appsettings.json i appsettings.Development.json 

datoteka nego iz docker-compose.yml datoteka. Preporuka je da se prepišu sve promenljive okruženja iz 

Yaml datoteka u json pre pokretanja. Naravno, ovime se onemogućava pojedinačno pokretanje projekata iz 

Visual Studio alata. 

• Debagiranje u kontejnerima je nešto sporije u odnosu na debagiranje aplikacija koje su pokrenute na host 

računaru, ali funkcioniše identično. 

Docker Desktop 

Alat Docker Desktop nam služi za upravljanje kontejnerima iz grafičke korisničke aplikacije. Na narednoj slici možemo 

videti prikaz nakon pokretanja. Sa strane možemo birati neke od tabova koji nam daju uvid u naredne elemente za 

rad sa kontejnerima: 

• Containers/Apps prikazuje pregled svih kontejnera koji postoje na sistemu 

• Images prikazuje pregled svih slika koji su dovučeni na sistemu 

• Volumes prikazuje pregled svih „diskova“ koje kontejneri koriste za trajno skladištenje datoteka 

• Dev Environments prikazuje pregled okruženja za razvoj za jednostavnu kolaboraciju razvijalaca softvera u 

timu 

Nama će najznačajniji biti prvi pregled. 
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Kontejneri mogu biti pokrenuti pojedinačno, ili kao deo neke mreže, tj. orkestra kontejnera. Na slici ispod je 

prikazana orkestrizacija celokupne aplikacija Webstore koja se, u ovom trenutku, sastoji od četiri kontejnera. Sa 

desne strane možemo videti zajedničke dnevnike, a klikom na konkretan kontejner, biće nam prikazan dnevnik samo 

za taj kontejner. 
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3. Sinhrona komunikacija između mikroservisa 

pomoću gRPC protokola 

Tema ovih časova je ostvarivanje sinhrone komunikacije između mikroservisa implementiranjem gRPC protokola.  

Videćemo i rad sa PostgreSQL SUBP korišćenjem vrlo jednostavne biblioteke za ORP – Dapper. 

1. Priprema PostgreSQL i pgadmin kontejnera 

Na stranici https://hub.docker.com/ uneti „postgres“ u polje za pretragu. Otvoriti sledeću stranicu: 

 

Na stranici https://hub.docker.com/ uneti „pgadmin“ u polje za pretragu. Otvoriti sledeću stranicu: 

 

Dodati naredne resurse u docker-compose.yml datoteku: 

services: 

  discountdb: 

    image: postgres 

 

  pgadmin: 

    image: dpage/pgadmin4 

 

volumes: 

  mongo_data: 

  postgres_data: 

  pgadmin_data: 

 

Dodati naredne resurse u docker-compose.override.yml datoteku: 

services: 

  discountdb: 

    container_name: discountdb 

    environment: 

      - POSTGRES_USER=admin 

https://hub.docker.com/
https://hub.docker.com/
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      - POSTGRES_PASSWORD=admin1234 

      - POSTGRES_DB=DiscountDb 

    restart: always 

    ports: 

        - "5432:5432" 

    volumes: 

      - postgres_data:/var/lib/postgresql/data/ 

 

  pgadmin: 

    container_name: pgadmin 

    environment: 

      - PGADMIN_DEFAULT_EMAIL=razvoj.softvera.matf@gmail.com 

      - PGADMIN_DEFAULT_PASSWORD=admin1234 

    restart: always 

    ports: 

        - "5050:80" 

    volumes: 

      - pgadmin_data:/root/.pgadmin 

Alat pgAdmin4 

Nakon pokretanja kontejnera, alat je dostupan na adresi http://localhost:5050. Prijaviti se na sistem korišćenjem 

adrese elektronske pošte i lozinke koji su navedeni u datoteci iznad. 

Dodavanje novog servera: 

• Add New Server 

• General 

o Name: DiscountServer 

• Connection 

o Host name/address: discountdb 

o Port: 5432 

o Maintenance database: postgres 

o Username: admin 

o Password: admin1234 

o Napomena za podatke iznad: username i password treba da budu isto kao u docker-

compose.override.yml datoteci. 

• Save 

Podesiti inicijalnu shemu baze podataka DiscountDB: 

• Tools > Query Tool 

• Izvršiti naredni upit: 

CREATE TABLE Coupon ( 

    ID SERIAL PRIMARY KEY NOT NULL, 

    ProductName VARCHAR(24) NOT NULL, 

    Description TEXT, 

    Amount INT 

); 

Sada kreirajmo nekoliko inicijalnih vrednosti: 

INSERT INTO Coupon (ProductName, Description, Amount) VALUES ('IPhone X', 'IPhone Discount', 150); 

INSERT INTO Coupon (ProductName, Description, Amount) VALUES ('Huawei Plus', 'Huawei Discount', 110); 

http://localhost:5050/
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INSERT INTO Coupon (ProductName, Description, Amount) VALUES ('Xiaomi Mi 9', 'Xiaomi Discount', 75); 

INSERT INTO Coupon (ProductName, Description, Amount) VALUES ('Samsung 10', 'Samsung Discount', 100); 

Nakon svake izvršene naredbe koja menja shemu je potrebno osvežiti pogled u Browser-u kako bi se videle izmene. 

2. Kreiranje zajedničkog projekta za API i gRPC projekte  

S obzirom da koristimo iste resurse u dva projekta, bilo bi dobro da izdvojimo sve zajedničke stvari iz tih projekata u 

jednu biblioteku klasa. Ovime izbegavamo dupliciranje koda, ali polako uvodimo slojevitost u našim projektima. Ovu 

ideju ćemo detaljnije produbiti kada budemo govorili o čistoj arhitekturi. 

Kreiranje projekta i  instalacija paketa  

Dodajemo novi projekat u okviru već napravljenog Solution-a: 

• Desni klik na ime Solution-a 

• Add > New Project 

• Class library 

• Popuniti neophodnim podacima: 

o Project name: Discount.Common 

o Location: LOKACIJA_LOKALNOG_REPOZITORIJUMA\Services\Discount 

• Next 

• Odabrati opciju .NET 5.0 (Current) 

• Create 

Pre nego što krenemo sa razvojem, potrebno je da instaliramo neophodne pakete. Otvoriti NuGet Package Manager 

sledećim koracima: 

• Desni klik na naziv projekta 

• Manage NuGet Packages 

Prvo ćemo ažurirati sve pakete koji su do sada instalirani: 

• Updates 

• Select all packages 

• Update 

Zatim je potrebno otvoriti tab „Browse“ i tu pronaći i instalirati sledeće pakete:  

• Npgsql 

• Dapper 

• AutoMapper.Extensions.Microsoft.DependencyInjection 

• Microsoft.Extensions.Configuration 

• Microsoft.Extensions.Configuration.Binder 

• Microsoft.Extensions.DependencyInjection.Abstractions 

Razvoj biblioteke klasa za Discount projekte 

Kodiranje vršimo prema narednom redosledu: 

• Entities 

o Coupon.cs 

• Data 

o ICouponContext.cs 

o CouponContext.cs 

• DTOs 
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o BaseCouponDTO.cs 

o BaseIdentityCouponDTO.cs 

o CouponDTO.cs 

o CreateCouponDTO.cs 

o UpdateCouponDTO.cs 

• Repositories 

o ICouponRepository.cs 

o CouponRepository.cs 

• Extensions 

o DiscountCommonExtensions.cs 

3. Kreiranje API projekta 

Dodajemo novi projekat u okviru već napravljenog Solution-a: 

• Desni klik na ime Solution-a 

• Add > New Project 

• ASP.NET Core Web API 

• Popuniti neophodnim podacima: 

o Project name: Discount.API 

o Location: 

LOKACIJA_LOKALNOG_REPOZITORIJUMA 

\Services\Discount 

• Next 

• Odabrati opcije kao na slici pored: 

• Create 

Pre nego što krenemo sa razvojem, potrebno je da dodamo 

referencu na prethodno napravljeni projekat 

Discount.Common: 

• Desni klik na naziv projekta 

• Add > Project Reference 

• Odabrati Discount.Common 

• Ok 

Razvoj mikroservisa 

API mikroservisa je opisan slikom pored. 

Prvo podešavamo opcije za pokretanje aplikacije:  

• Desni klik na naziv projekta 

• Properties 

• Debug 

• Podesiti opcije sa slike pored. 

Zatim prelazimo na kodiranje, prema narednom redosledu: 

• Controllers 

o DiscountController.cs 

Sada je preostalo da dodamo ubrizgavanje zavisnosti, što se nalazi u 

Startup.cs datoteci. 
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Pokretanje i debagiranje aplikacije 

Pokrenuti prvo docker-compose projekat iz terminala, a ujedno pokrenuti samo Discount.API projekat iz Visual 

Studio alata. Discount.API projekat bi trebalo da se poveže sa PostreSQL bazom podataka ukoliko se u 

appsettings.Development.json datoteci doda naredna konfiguracija: 

  "DatabaseSettings": { 

    "ConnectionString": "Server=localhost;Port=5432;Database=DiscountDb;User Id=admin;Password=admin1234;"  

  } 

Sada dodati podršku za orkestrizaciju kontejnera za projekat Discount.API, pa pokrenuti sve kontejnere i testirati još 

jednom. Dopuniti docker-compose.override.yml datoteku narednim linijama: 

  discount.api: 

    container_name: discount.api 

    environment: 

      - ASPNETCORE_ENVIRONMENT=Development 

      - "DatabaseSettings:ConnectionString=Server=discountdb;Port=5432;Database=DiscountDb;User 

Id=admin;Password=admin1234;" 

    depends_on: 

      - discountdb 

    ports: 

      - "8002:80" 

4. Kreiranje gRPC projekta 

Dodajemo novi projekat u okviru već napravljenog Solution-a: 

• Desni klik na ime Solution-a 

• Add > New Project 

• ASP.NET Core gRPC Service 

• Popuniti neophodnim podacima: 

o Project name: Discount.GRPC 

o Location:  

LOKACIJA_LOKALNOG_REPOZITORIJUMA 

\Services\Discount 

o Next 

• Odabrati opcije kao na slici pored. 

• Create 

Pre nego što krenemo sa razvojem, potrebno je da dodamo referencu na prethodno napravljeni projekat 

Discount.Common: 

• Desni klik na naziv projekta 

• Add > Project Reference 

• Odabrati Discount.Common 

• Ok 

Sada ažurirajmo neophodne pakete: 

• Desni klik na naziv projekta 

• Manage NuGet Packages 

• Updates 

• Select all packages 
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• Update 

Zatim je potrebno otvoriti tab „Browse“ i tu pronaći i instalirati sledeće pakete:  

• Google.Protobuf 

• Grpc.Core 

• Grpc.Tools 

Ako se i dalje pojavljuje greška u Build prozoru, samo očistiti i ponovo izgraditi projekat. 

Razvoj mikroservisa 

Prvo podešavamo opcije za pokretanje aplikacije:  

• Desni klik na naziv projekta 

• Properties 

• Debug 

• Podesiti opcije sa slike pored:  

Da bismo implementirali gRPC protokol, potrebno je 

da postoje dve strane u komunikaciji: server i klijent.  

Server je onaj mikroservis koji opslužuje druge nekim 

servisima, a klijent je onaj mikroservis koji koristi 

usluge nekih servera. U našem primeru, server je 

Discount.GRPC zato što on omogućava da se pretraže 

kuponi za dati proizvod, a Basket.API je klijent zato što 

on koristi tu uslugu pretrage kupona kako bi odredio 

konačnu cenu potrošačke korpe. 

Za gRPC implementaciju su potrebne dve stvari: 

• proto buffer datoteka koja opisuje gRPC servise 

• C# klasa koja implementira te opisane servise 

Generisanje proto buffer datoteke se radi narednim koracima: 

• Desni klik na direktorijum Protos 

• Add > New Item 

• Protocol Buffer File 

• Name: coupon.proto 

Sada je potrebno definisati servise koje želimo da omogućimo. U tu svrhu se koristi proto3 sintaksa (više o ovom 

jeziku na https://developers.google.com/protocol-buffers/docs/proto3). Obavezno postaviti da se datoteka koristi za 

potrebe definisanja gRPC servera: 

• Desni klik na proto buffer datoteku > Properties 

• Build action: Protobuf compiler 

• gRPC Stub Classes: Server Only 

Kada se završi pisanje proto buffer datoteke, možemo generisati implementaciju narednim koracima: 

• Desni klik na direktorijum Services 

• Add > Class 

• Name: CouponService 

• Naslediti klasu CouponProtoService.CouponProtoServiceBase 

• Desni klik na našu klasu > Generate overrides 

https://developers.google.com/protocol-buffers/docs/proto3
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Sada smo dobili potpise metoda koje implementiramo kako god želimo. Ova klasa predstavlja na neki način 

kontroler, samo što koristi gRPC protokol umesto HTTP. 

Ne zaboraviti da je potrebno da se u Startup.cs doda rutiranje gRPC servisa u HTTP pipeline-u: 

endpoints.MapGrpcService<CouponService>(); 

kao i ubrizgavanje zavisnosti i preslikavanje neophodnih modela: 

services.AddDiscountCommonServices(); 

services.AddAutoMapper(configuration => 

{ 

    configuration.CreateMap<Coupon, CouponModel>().ReverseMap(); 

}); 

Pokretanje i debagiranje aplikacije 

Pokrenuti prvo docker-compose projekat iz terminala, a ujedno pokrenuti samo Discount.GRPC projekat iz Visual 

Studio alata. Discount.GRPC projekat bi trebalo da se poveže sa PostreSQL bazom podataka ukoliko se u 

appsettings.Development.json datoteci doda naredna konfiguracija: 

  "DatabaseSettings": { 

    "ConnectionString": "Server=localhost;Port=5432;Database=DiscountDb;User Id=admin;Password=admin1234;" 

  } 

Otvoriti BloomRPC alat, učitati proto buffer datoteku i testirati gRPC servis slanjem zahteva kao na narednoj slici. Pre 

prikazivanja slike napomenimo sledeće: 

• Dok se testira projekat kad je pokrenut lokalno, u alatu upisati adresu localhost:5003 

• Dok se testira projekat u kontejneru, u alatu upisati adresu localhost:8003 

 

Sada dodati podršku za orkestrizaciju kontejnera za projekat Discount.GRPC, pa pokrenuti sve kontejnere i testirati 

još jednom. Dopuniti docker-compose.override.yml datoteku narednim linijama: 

  discount.grpc: 

    container_name: discount.grpc 

    environment: 

      - ASPNETCORE_ENVIRONMENT=Development 
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      - "DatabaseSettings:ConnectionString=Server=discountdb;Port=5432;Database=DiscountDb;User 

Id=admin;Password=admin1234;" 

    depends_on: 

      - discountdb 

    ports: 

      - "8003:80" 

5. Korišćenje gRPC projekta u Basket mikroservisu 

Vratimo se sada na Basket.API mikroservis kako bismo dodali neophodan kod za ostvarivanje gRPC komunikacije ka 

Discount.GRPC mikroservisu. Koraci koje je neophodno izvršiti su slični kao za server, ali neke stvari je moguće 

ubrzati: 

• Registracija gRPC servisa 

• Implementacija klijentske logike 

• Dodavanje informacija o gRPC komunikaciji i ubrizgavanje zavisnosti 

Da bismo registrovali novi gRPC servis, potrebno je da uradimo naredne korake: 

• Desni klik na naziv Basket.API projekta 

• Add > Connected Service 

• U okviru „Service References (OpenAPI, gRPC, WCF Web Service)“ odabrati dugme „+“ 

• gRPC 

• File > Browse 

• Pronaći proto buffer datoteku koju smo implementirali na serveru. Trebalo bi da bude na putanji oblika 

LOKACIJA_LOKALNOG_REPOZITORIJUMA\Services\Discount\Discount.GRPC\Protos\coupon.proto 

• Select the type of class to be generated: Client 

• Finish 

• Close 

Sada možemo da napravimo klasu koju ćemo koristiti u ovom projektu, a koja se oslanja na automatski generisanog 

klijenta u gRPC komunikaciji: 

• GrpcServices 

o CouponGrpcService.cs 

• Controllers 

o BasketController.cs 

Konačno, neophodno je da u Startup.cs datoteci navedemo podešavanja za gRPC komunikaciju. Najpre, potrebno je 

da navedemo koji gRPC servis „gađa“ generisani klijent, kao i da ubrizgamo klasu koju smo mi implementirali iznad: 

services.AddGrpcClient<CouponProtoService.CouponProtoServiceClient> 

    (o => o.Address = new Uri(Configuration["GrpcSettings:DiscountUrl"])); 

services.AddScoped<CouponGrpcService>(); 

Očigledno, neophodno je dodati adresu u konfiguraciju, jedanput u datoteci appsettings.Development.json i 

jedanput u docker-compose.override.yml. Dodatno, u drugoj datoteci je potrebno navesti da Basket.API mikroservis 

očekuje da Discount.GRPC servis bude pokrenut pre njega. 

U appsettings.Development.json datoteci: 

  "GrpcSettings": { 

    "DiscountUrl": "http://localhost:5003" 

  } 
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U docker-compose.override.yml datoteci: 

  basket.api: 

    container_name: basket.api 

    environment: 

      - ASPNETCORE_ENVIRONMENT=Development 

      - "CacheSettings:ConnectionString=basketdb:6379" 

      - "GrpcSettings:DiscountUrl=http://discount.grpc" 

    depends_on: 

      - basketdb 

      - discount.grpc 

    ports: 

      - "8001:80" 

Za testiranje PUT zahteva za Basket.API mikroservis se može koristiti naredni JSON kod: 

{ 

  "username": "rs2", 

  "items": [ 

    { 

      "quantity": 2, 

      "color": "white", 

      "price": 950, 

      "productId": "602d2149e773f2a3990b47f5", 

      "productName": "IPhone X" 

    }, 

    { 

      "quantity": 1, 

      "color": "white", 

      "price": 380, 

      "productId": "602d2149e773f2a3990b47f9", 

      "productName": "HTC U11+ Plus" 

    } 

  ] 

} 

Ono što možemo primetiti sa slike ispod jeste da se u odgovoru zahteva primenio kupon na uređaj „IPhone X“, ali da 

je uređaj „HTC U11+ Plus“ zadržao svoju originalnu cenu. 
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4. Razvoj vođen domenom. Čista arhitektura. CQRS. 

Tema ovih časova je razvoj složenijih mikroservisa. Razvoj vođen domenom (Domain-Driven Design, DDD) omogućuje 

nam da, vodeći se OOP principima, implementiramo poslovne procese u skladu sa zahtevima koji su prepoznati od 

strane eksperata u domenu. Čista arhitektura nam omogućava da grupišemo kolekcije klasa na način koji omogućava 

nesmetan razvoj. CQRS pristup predstavlja razdvajanje odgovornosti operacija koji se odigravaju u sistemu. 

1. Razvoj vođen domenom 

• Proći kroz prezentaciju „Razvoj vođen domenom“: http://rs2.matf.bg.ac.rs/vezbe/ddd.pdf  

2. Čista arhitektura 

Čista arhitektura (ovde se više misli na dizajn, s obzirom da je ovo arhitektura u okviru jednog mikroservisa, a ne 

celog sistema) podrazumeva da se kod unutar mikroservisa podeli na slojeve. Slojevi mogu da zavise jedni od drugih, 

pri čemu razlikujemo: 

• Zavisnost u fazi prevođenja koda 

• Zavisnost u fazi izvršavanja aplikacije  

Slojevi u čistoj arhitekturi su: 

• Sloj domena (jezgro aplikacije koje čine POCO klase koje opisuju domen sistema) 

• Sloj aplikacije (interfejsi koji se oslanjaju na logiku iz domena, a predstavljaju uslove koje ostali resursi 

moraju da zadovoljavaju) 

• Sloj infrastrukture (implementacija interfejsa iz sloja aplikacije, često korišćenjem spoljašnjih resursa, kao što 

je komunikacija za raznim SUBP, skladištenje dokumenata u oblacima, slanje elektronske pošte, ...) 

• Sloj API-ja ili korisničkog interfejsa (implementacija korisničkih zahteva, generisanje HTML stranica, ...) 

Na slici pored su prikazani ovi slojevi u horizontalnom 

rasporedu. Puna linija predstavlja zavisnost u fazi prevođenja 

koda, a isprekidana u fazi izvršavanja koda. 

Slika ispod prikazuje drugi pogled na istu arhitekturu, pri čemu 

slojevi koji su spolja zavise od slojeva koji su unutra: 

• API/UI i infrastruktni slojevi zavise od aplikacionog sloja 

• Aplikacioni sloj zavisi od domena 

 

http://rs2.matf.bg.ac.rs/vezbe/ddd.pdf
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Naredna slika prikazuje još detaljniji pogled na istu arhitekturu: 

 

Važno je uzeti u obzir i mesto testova u ovoj arhitekturi. Ono što je ispostavlja kao velika prednost čiste arhitekture 

jeste što razdvajanje koda po slojevima omogućava ograničenost konteksta koja je neophodna testovima, kao i 

izolovanost testova po slojevima. Naredne dve slike prikazuju na kojim mestima bi se testovi jedinica koda i 

integracioni testovi smestili u ovoj arhitekturi. 

   

Drugim rečima, s obzirom da domenski i aplikacioni slojevi ne zavise od arhitekture, vrlo je jednostavno pisati testove 

koji su izolovani samo za te slojeve. Sa druge strane, s obzirom da se API/UI ne oslanja na tipove iz infrastrukturnog 

sloja, vrlo je jednostavno zameniti implementacije koje se koriste u obradi zahteva, bilo za potrebe izvršavanja 

testova ili radi izmena u zahtevima aplikacije (u ovome nam značajno pomaže i ubrizgavanje zavisnosti).  

3. CQRS 

Ukratko proći kroz članak https://martinfowler.com/bliki/CQRS.html i skrenuti pažnju na postojanje koncepta Event 

Sourcing (više o tome sa primerima implementacije na https://martinfowler.com/eaaDev/EventSourcing.html). 

Pogledati i Microsoftov priručnik za obrasce na temu Event Sourcing-a (https://docs.microsoft.com/en-

us/azure/architecture/patterns/event-sourcing). 

https://martinfowler.com/bliki/CQRS.html
https://martinfowler.com/eaaDev/EventSourcing.html
https://docs.microsoft.com/en-us/azure/architecture/patterns/event-sourcing
https://docs.microsoft.com/en-us/azure/architecture/patterns/event-sourcing
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4. Implementacija Ordering mikroservisa  

U nastavku prikazujemo samo redosled implementacije slojeva i elemenata u okviru tih slojeva. Očekuje se da su 

čitaoci u stanju da rekonstruišu kod na osnovu ovih beleški i koda sa repozitorijuma. 

Ordering.Domain projekat 

Tip projekta: Class library 

Paketi: / 

Zavisnosti od drugih slojeva: / 

Implementacija: 

• Common 

o EntityBase.cs 

o ValueObjectBase.cs 

o AggregateRoot.cs 

• Entities 

o OrderItem.cs 

• Exceptions 

o OrderingDomainException.cs 

• ValueObjects 

o Address.cs 

• Aggregates 

o Order.cs 

Ordering.Application projekat 

Tip projekta: Class library 

Paketi: 

• MediatR 

• MediatR.Extensions.Microsoft.DependencyInjection 

• FluentValidation 

• FluentValidation.DependencyInjectionExtensions 

• Microsoft.Extensions.Logging.Abstractions 

Zavisnosti od drugih slojeva: 

• Ordering.Domain 

Implementacija: 

• Contracts 

o Persistence 

▪ IAsyncRepository.cs 

▪ IOrderRepository.cs 

o Infrastructure 

▪ IEmailService.cs 

• Models 

o Email.cs 

o EmailSettings.cs 
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Pre nego što nastavimo sa implementacijom, vredno je pomenuti kako nam MediatR paket omogućava da 

implementiramo CQRS.  

 

Dakle, prvo je neophodno da definišemo upite i naredbe, a zatim da definišemo tzv. handler klase, koji će obrađivati 

zahteve. Preporučuje se da upiti i naredbe imaju nezavisne modele, kako bi bili u skladu sa CQRS obrascem. Mi ćemo 

sve klase držati u aplikativnom sloju, ali ćemo ih koristiti potpuno nezavisno. 

Dakle, prvo definišemo upite i naredbe za CQRS obrazac korišćenjem MediatR paketa. Takođe, želimo da definišemo i 

Data Transfer Object-e (https://martinfowler.com/eaaCatalog/dataTransferObject.html), koji se često u CQRS 

obrascu nazivaju ViewModel-i ako se koriste kao rezultati upita. 

• Features 

o Orders 

▪ Queries 

• GetListOfOrders 

o GetListOfOrdersQuery.cs 

• ViewModels 

o OrderViewModel.cs 

o OrderItemViewModel.cs 

▪ Commands 

• DTOs 

o OrderItemDTO.cs 

• CreateOrder 

o CreateOrderCommand.cs 

• UpdateOrder 

o UpdateOrderCommand.cs 

• DeleteOrder 

o DeleteOrderCommand.cs 

• Contracts 

o Factories 

▪ IOrderFactory.cs 

▪ IorderViewModelFactory.cs 

Zatim, dodajemo handler klase za napisane upite i naredbe. 

• Features 

o Orders 

https://martinfowler.com/eaaCatalog/dataTransferObject.html
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▪ Queries 

• GetListOfOrders 

o GetListOfOrdersQueryHandler.cs 

▪ Commands 

• CreateOrder 

o CreateOrderCommandHandler.cs 

• UpdateOrder 

o UpdateOrderCommandHandler.cs 

• DeleteOrder 

o DeleteOrderCommandHandler.cs 

Dobra stvar kod MediatR paketa jeste što nam omogućava da izvršavamo akcije  pre i 

posle pozivanja handler operacija, kao na slici pored. Ono što dobijamo na ovaj način 

jeste razdvajanje implementacije poslovne logike u našem sistemu (što se 

implementira u samim handler klasama) od raznih drugih operacija koje su 

neophodne za izvršavanje poslovne logike, ali nisu deo nje : 

• Primer pre processor behavior: validacija podataka 

• Primer post processor behavior: obrada grešaka 

Sada ćemo videti kako je moguće dodavati ove akcije jednostavno pomoću MediatR 

paketa. Za početak, definišimo validatore za obradu naredbi i izuzetke koji se mogu 

javljati: 

• Features 

o Orders 

▪ Commands 

• CreateOrder 

o CreateOrderCommandValidator.cs 

• UpdateOrder 

o UpdateOrderCommandValidator.cs 

• DeleteOrder 

o DeleteOrderCommandValidator.cs 

• Exceptions 

o EntityNotFoundException.cs 

o ValidationFailedException.cs 
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Sada možemo dodati implementacije ponašanja. Pre implementacije, važno je razumeti kako jedna funkcija poziva 

drugu u obradi zahteva, što je ilustrovano na slici iznad. Više o ponašanjima je dostupno na 

https://github.com/jbogard/MediatR/wiki/Behaviors. 

• Behaviours 

o ValidationBehavior.cs 

o UnhandledExceptionBehavior.cs 

Konačno, neophodno je da definišemo klasu proširenja za ubrizgavanje zavisnosti svih servisa koje smo definisali. 

Važno je napomenuti da će se ova klasa koristiti samo u API sloju, pošto je to sloj koji predstavlja Web API projekat, 

dok aplikacioni sloj samo definiše interfejse i klase koje drugi koriste.  Redosled registracije ponašanja odgovara 

redosledu izvršavanja1. 

• ApplicationServiceRegistration.cs 

Naravno, ovu klasu koristimo u API projektu. 

Ordering.API projekat 

Tip projekta: ASP.NET Core Web API 

Paketi: 

• Microsoft.EntityFrameworkCore.Tools 

• Polly 

Zavisnosti od drugih slojeva: 

• Ordering.Application 

• Odering.Infrastructure 

Podešavanja: 

• App URL: http://localhost:5004 

Implementacija: 

• Controllers 

o OrderController.cs 

Napomenimo da ovde nije završena implementacija ovog projekta i da ćemo se vratiti na njega kada završimo 

implementaciju sloja infrastrukture. 

  

 
1 Neko će se zapitati zašto registrujemo prvo UnhandlerExceptionBehaviour, pa tek onda ValidationBehaviour kada se prvo radi 
validacija, pa tek onda obrada grešaka. Važno je razumeti koje ponašanje se izvršava pre neke akcije, a koje ponašanje posle 
neke akcije. Ako pogledamo definicije ovih klasa, vidimo da se u klasi ValidationBehaviour poziv „next()“ izvršava tek na kraju 

metoda Handle, što znači da se logika ovog ponašanja izvršava pre obrade zahteva. Sa druge strane, u Handle metodu klase 
UnhandlerExceptionBehaviour, poziv „next()“ se izvršava na samom početku (try blok), a sam čin obrade grešaka (catch blok) 
biće izvršen tek ako prilikom obrade zahteva bude ispaljen neki izuzetak, što znači da se logika ovog ponašanja izvršava posle 
obrade zahteva. 

https://github.com/jbogard/MediatR/wiki/Behaviors
http://localhost:5004/
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5. Entity Framework Core 

Tema ovih časova je Entity Framework Core. U pitanju je radni okvir za ORP. Dodatno, koristićemo Sql Server RSUBP 

za skladištenje podataka. 

1. Priprema SQL Server kontejnera 

Na stranici https://hub.docker.com/ uneti „microsoft“ u polje za pretragu. Otvoriti sledeću stranicu: 

 

Dodati naredne resurse u docker-compose.yml datoteku: 

services: 

  orderdb: 

    image: mcr.microsoft.com/mssql/server:2017-latest 

 

volumes: 

  mssql_data: 

 

Dodati naredne resurse u docker-compose.override.yml datoteku: 

services: 

  orderdb: 

    container_name: orderdb 

    environment: 

      - SA_PASSWORD=MATF12345678rs2 

      - ACCEPT_EULA=Y 

    restart: always 

    ports: 

      - "1433:1433" 

    volumes: 

      - mssql_data:/var/opt/mssql/data 

2. Ordering.Infrastructure projekat 

Tip projekta: Class library 

Paketi: 

• Microsoft.EntityFrameworkCore.SqlServer 

• MailKit 

• MimeKit 

Zavisnosti od drugih slojeva: 

https://hub.docker.com/
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• Ordering.Application 

U EF Core radnom okviru, prvi korak jeste definisanje konteksta za jednu bazu podataka. Ovaj kontekst  služi za 

definisanje podešavanja i tabele koji su vezani za bazu podataka koja se koristi. Videćemo kasnije kako se koristi ovaj 

kontekst za definisanje migracija baza podataka.  

Posebno obraćamo pažnju na implementaciju ORP između agregata/entiteta i vrednostih objekata. Vrednosti objekti 

nemaju identitet, pa po definiciji, ne smeju se čuvati kao nezavisni objekti u BP  (tj. objekti koji imaju svoj, nezavisan 

identifikator). Više o ovoj strategiji u članku https://docs.microsoft.com/en-

us/dotnet/architecture/microservices/microservice-ddd-cqrs-patterns/implement-value-objects#persist-value-

objects-as-owned-entity-types-in-ef-core-20-and-later.  

Implementacija: 

• Persistence 

o EntityConfigurations 

▪ OrderItemEntityTypeConfiguration.cs 

▪ OrderEntityTypeConfiguration.cs 

o OrderContext.cs 

o OrderContextSeed.cs 

• Repositories 

o RepositoryBase.cs2 

o OrderRepository.cs 

• Factories 

o OrderFactory.cs 

o OrderViewModelFactory.cs 

• Mail 

o EmailService.cs34 

Konačno, definišemo klasu proširenja InfrastructureServiceRegistration za ubrizgavanje zavisnosti implementiranih 

servisa i koristimo ovu klasu u API projektu. Ne zaboraviti na dodavanje niske za konekciju na Sql Server i 

podešavanja za elektronsku poštu5: 

  "ConnectionStrings": { 

    "OrderingConnectionString": "Server=localhost;Database=OrderDb;User Id=sa;Password=MATF12345678rs2;" 

  }, 

  "EmailSettings": { 

    "Mail": "destin.schroeder4@ethereal.email", 

    "DisplayName": "Webstore App", 

    "Password": "m7y9PEZzayQj7nkYCZ", 

    "Host": "smtp.ethereal.email", 

    "Port": 587 

  } 

 
2 Važna napomena za efikasnu implementaciju operacija nad bazom podataka: preferirati IQueryable interfejs nad IEnumerable 
interfejsom. Više o tome na https://www.tutorialspoint.com/what-is-the-difference-between-ienumerable-and-iqueryable-in-
chash i https://medium.com/@mohamedabdeen/iqueryable-vs-ienumerable-in-net-92a15a803da3.  
3 Podešavanje za Gmail SMTP server: https://support.google.com/a/answer/176600#zippy=%2Cuse-the-gmail-smtp-server. 
4 Članak koji opisuje jednostavno slanje elektronske pošte putem Gmail i Etherea l servisa: 
https://codewithmukesh.com/blog/send-emails-with-aspnet-core/. 
5 Jednostavno kreiranje naloga za mockup SMTP server: https://ethereal.email/.  

https://docs.microsoft.com/en-us/dotnet/architecture/microservices/microservice-ddd-cqrs-patterns/implement-value-objects#persist-value-objects-as-owned-entity-types-in-ef-core-20-and-later
https://docs.microsoft.com/en-us/dotnet/architecture/microservices/microservice-ddd-cqrs-patterns/implement-value-objects#persist-value-objects-as-owned-entity-types-in-ef-core-20-and-later
https://docs.microsoft.com/en-us/dotnet/architecture/microservices/microservice-ddd-cqrs-patterns/implement-value-objects#persist-value-objects-as-owned-entity-types-in-ef-core-20-and-later
https://www.tutorialspoint.com/what-is-the-difference-between-ienumerable-and-iqueryable-in-chash
https://www.tutorialspoint.com/what-is-the-difference-between-ienumerable-and-iqueryable-in-chash
https://medium.com/@mohamedabdeen/iqueryable-vs-ienumerable-in-net-92a15a803da3
https://support.google.com/a/answer/176600#zippy=%2Cuse-the-gmail-smtp-server
https://codewithmukesh.com/blog/send-emails-with-aspnet-core/
https://ethereal.email/
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3. Migracije baza podataka 

Migracija predstavlja proces inkrementalnog rekreiranja baze podataka na (najčešće) udaljenom SUBP. Pod 

inkrementalnim rekreiranjem podrazumevamo da se BP menja postepeno, tokom životnog ciklusa projekta. 

Migracije su važne zato što često ne možemo na početku projekta predvideti kako će sheme podataka tačno 

izgledati, već se vremenom te sheme menjaju, pa je neophodno promeniti i samu BP. Više o migracijama je dostupno 

u članku https://docs.microsoft.com/en-us/ef/core/managing-schemas/migrations/?tabs=dotnet-core-cli.  

Migracija se može uraditi ručno, povezivanjem na SUBP i izvršavanjem naredbi (kao što smo radili za Discount.API 

projekat) ili automatski, korišćenjem raznih alata za automatizaciju ovog postupka. EF Core nudi takve alate koji su 

zasnovani na tzv. code-first pristupu, gde se na osnovu izvornog koda generišu klase koji će biti izvršeni nad SUBP-a 

kada se projekat pokrene. Ovi alati su dostupni u Visual Studio alatu kroz „Package Manager Console“ prozor, a iz 

terminala operativnog sistema kroz dotnet ef alat (više o ovom alatu na https://docs.microsoft.com/en-

us/ef/core/cli/dotnet). Otvaranje prozora u Visual Studio alatu se može uraditi narednim koracima: 

• Tools > Nuget Package Manager > Package Manager Console 

Na početku, kada se kod implementira, potrebno je dodati inicijalnu migraciju. 

• Otvoriti Package Manager Console 

• Odabrati „Services\Ordering\Ordering.Infrastructure“ kao podrazumevani projekat na vrhu konzole  

• Pokrenuti komandu „Add-Migration InitialCreate“ 

Rezultat ove akcije jeste generisana klasa koja je oblika <VREMENSKA_ODREDNICA>_InitialCreate.cs i nalazi se u 

direktorijumu Migrations. Ona sadrži metod Up za „podizanje“ migracije. 

Postoji još nekoliko operacija koje su od značaja i koje su navedene u nastavku. Svaki put kada se neka od ovih 

operacija izvrši, kreira se nova klasa koja sadrži novi kod koji menja BP kako bi u svakom trenutku stanje u BP 

odgovaralo stanju u kodu. 

• Dodavanje nove izmene:  

o PMC: https://docs.microsoft.com/en-us/ef/core/cli/powershell#add-migration  

o CLI: https://docs.microsoft.com/en-us/ef/core/cli/dotnet#dotnet-ef-migrations-add  

• Poništavanje poslednje izmene:  

o PMC: https://docs.microsoft.com/en-us/ef/core/cli/powershell#remove-migration  

o CLI: https://docs.microsoft.com/en-us/ef/core/cli/dotnet#dotnet-ef-migrations-remove  

• Izmena BP do poslednje, ili neke određene izmene:  

o PMC: https://docs.microsoft.com/en-us/ef/core/cli/powershell#update-database  

o CLI: https://docs.microsoft.com/en-us/ef/core/cli/dotnet#dotnet-ef-database-update  

• Uklanjanje baze podataka:  

o PMC: https://docs.microsoft.com/en-us/ef/core/cli/powershell#drop-database  

o CLI: https://docs.microsoft.com/en-us/ef/core/cli/dotnet#dotnet-ef-database-drop  

Sada je potrebno da napišemo klasu proširenja u Ordering.API projektu koju ćemo koristiti kako bismo rekli aplikaciji 

da izvrši migraciju: 

• Extensions 

o HostExtensions.cs 

• Program.cs 

Sada je moguće testirati API projekat iz Visual Studio okruženja. Pre dodavanja migracije bi pokušaj pristupanja 

rezultovao greškom u fazi povezivanja na bazu podataka. 

https://docs.microsoft.com/en-us/ef/core/managing-schemas/migrations/?tabs=dotnet-core-cli
https://docs.microsoft.com/en-us/ef/core/cli/dotnet
https://docs.microsoft.com/en-us/ef/core/cli/dotnet
https://docs.microsoft.com/en-us/ef/core/cli/powershell#add-migration
https://docs.microsoft.com/en-us/ef/core/cli/dotnet#dotnet-ef-migrations-add
https://docs.microsoft.com/en-us/ef/core/cli/powershell#remove-migration
https://docs.microsoft.com/en-us/ef/core/cli/dotnet#dotnet-ef-migrations-remove
https://docs.microsoft.com/en-us/ef/core/cli/powershell#update-database
https://docs.microsoft.com/en-us/ef/core/cli/dotnet#dotnet-ef-database-update
https://docs.microsoft.com/en-us/ef/core/cli/powershell#drop-database
https://docs.microsoft.com/en-us/ef/core/cli/dotnet#dotnet-ef-database-drop
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4. Kontejnerizacija Ordering.API projekta 

Prvo dodajemo podršku za orkestrizaciju za Docker Compose alat. Zatim, dodaje mo naredne opcije u docker-

compose.override.yml datoteci: 

services: 

  ordering.api: 

    container_name: ordering.api 

    environment: 

      - ASPNETCORE_ENVIRONMENT=Development 

      - "ConnectionStrings:OrderingConnectionString=Server=orderdb;Database=OrderDb;User 

Id=sa;Password=MATF12345678rs2"   

    depends_on: 

        - orderdb 

    ports: 

        - "8004:80" 
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6. Asinhrona komunikacija između mikroservisa 

pomoću reda poruka 

Tema ovih časova je ostvarivanje asinhrone komunikacije između mikroservisa implementiranjem RabbitMQ reda 

poruka. 

1. Osnovni elementi RabbitMQ posrednika 

Posrednici (eng. broker) predstavljaju sisteme koji učestvuju u komunikaciji između  više aplikacija radi ostvarivanja 

nekog slučaja upotrebe. U savremenim aplikacijama, posrednici se koriste za implementaciju asinhronih akcija na 

nivou sistema, odnosno, za ostvarivanje asinhrone komunikacije između komponenti tog sistema . RabbitMQ je 

primer jednog posrednika. Da bismo razumeli kako posrednici omogućavaju asinhronu saradnju , potrebno je da 

razumemo osnovne elemente AMQP 0-9-1 protokola koji se koristi u RabbitMQ sistemu.  

 

Osnovni elementi AMQP (Advanced Message Queuing Protocol) protokola su: 

• Poruka (eng. message) predstavlja objekat koji nosi neku informaciju. 

• Proizvođač (eng. producer) jeste aplikacija koja kreira i šalje poruke. 

• Red (eng. queue) predstavlja bafer koji čuva poruke. Svaki red može imati neke važne karakteristike kojima 

se može definisati specifično ponašanje tog reda: 

o Ime (za prepoznavanje reda), 

o Trajnost (red „preživljava“ restartovanje posrednika), 

o Ekskluzivnost (koristi se samo od strane jedne konekcije i biće uništen kada se konekcija završi), 

o Automatsko brisanje (red koji ima makar jednog pretplatnika biće obrisan kada se poslednji 

pretplatnik otplati sa njega), 

o Argumenti (opciona svojstva kao što su, na primer, najveća dužina reda, vreme tokom kojeg će 

poruka ili red ostati živi, itd.). 

• Pretplatnik (eng. consumer) predstavlja aplikaciju koja dobija poruke. 

• Proksi (eng. exchange) jeste podsistem koji dobija poruke od proizvođača i odlučuje na koji red (ili na više 

njih) dodaje poruku koju je dobio. Kako bi odlučio koji redovi će dobiti novu poruku, proksiji moraju definisati 

svoj tip. U RabbitMQ imamo četiri tipa proksija: 

o Direktan proksi (eng. direct), koji šalje poruku u redove na osnovu ključa za rutiranje (routing key). 

Red veže direktan proksi za sebe pomoću nekog ključa za rutiranje K. Kada nova poruka sa ključem za 

rutiranje R dođe do direktnog proksija, taj proksi šalje  poruku na red ako važi R=K. 
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o Proksi za emitovanje (eng. fanout), koji šalje poruku svim redovima koji su vezani za njega, bez obzira 

na ključeve za rutiranje. 

o Tematski proksi (eng. topic), koji šalje poruku na jedan red ili više njih na osnovu poklapanja između 

ključa za rutiranje i šablona koji se koristio za vezivanje reda na proksi.  

o Proksi zaglavlja (eng. headers), koji koristi složeniji skup atributa za određivanje pravila za rutiranje  u 

odnosu na jednostavan ključ za rutiranje. Ovaj skup atributa nazivamo zaglavljem poruke. 

Direktan proksi Proksi za emitovanje 

 
 

Tematski proksi Proksi zaglavlja 

  

2. Priprema RabbitMQ kontejnera 

Na stranici https://hub.docker.com/ uneti „rabbitmq“ u polje za pretragu. Otvoriti sledeću stranicu: 

 

https://hub.docker.com/
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Dodati naredne resurse u docker-compose.yml datoteku: 

services: 

  rabbitmq: 

    image: rabbitmq:3-management-alpine 

 

Dodati naredne resurse u docker-compose.override.yml datoteku: 

services: 

  rabbitmq: 

    container_name: rabbitmq 

    restart: always 

    ports: 

      - "5672:5672" 

      - "15672:15672" 

 

Koristimo „management“ verziju kontejnera kako bismo dobili i UI alat koji se zove Management plugin i koji nam 

omogućava da pratimo stanje u redu poruka. Sam red poruka će biti pokrenut na portu 5672, dok će alat biti 

pokrenut na portu 15672. Više o Management pluginu na: https://www.rabbitmq.com/management.html. 

Podrazumevano korisničko ime i lozinka za pristup alatu je guest/guest. 

3. EventBus.Messages projekat 

Ovaj projekat nam služi za definisanje zajedničkih elemenata koji će imati svi mikroservisi, te je ovo dobro mesto za 

definisanje klasa za poruke koje će mikroservisi razmenjivati, kao što je poruka „kupac je završio kupovinu“ u našoj 

prodavnici. 

Tip projekta: Class library 

Implementacija: 

• Events 

o IntegrationBaseEvent.cs 

o BasketCheckoutEvent.cs 

• Common 

o EventBusConstants.cs 

4. Objavljivanje poruke iz Basket API mikroservisa  

U Basket.API projektu moramo dodati referencu na EventBus.Messages projekat. 

Dodatno, potrebno je da instaliramo NuGet pakete za korišćenje redova poruka: 

• MassTransit 

• MassTransit.RabbitMQ 

• MassTransit.AspNetCore 

• AutoMapper.Extensions.Microsoft.DependencyInjection 

U Startup.cs datoteci dodati podešavanje za red poruka i ubrizgavanje zavisnosti: 

services.AddMassTransit(config => { 

    config.UsingRabbitMq((ctx, cfg) => { 

      cfg.Host(Configuration["EventBusSettings:HostAddress"]); 

    }); 

  }); 

https://www.rabbitmq.com/management.html
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services.AddMassTransitHostedService(); 

U appsettings.development.json datoteci dodati URI za konekciju na red poruka: 

  "EventBusSettings": { 

    "HostAddress": "amqp://guest:guest@localhost:5672" 

  } 

Implementacija: 

• Entities 

o BasketCheckout.cs 

o BasketItem.cs 

• Controllers 

o BasketController.cs 

• Mapper 

o BasketProfile.cs 

Dodati DI za AutoMapper u Startup.cs datoteci. 

5. Pretplaćivanje na poruke u Ordering API mikroservisu 

Dodati iste reference, NuGet pakete i podešavanja kao za Basket.API projekat u prethodnoj sekciji. Jedina razlika 

jeste što se Ordering API koristi kao pretplatnik u redu poruka, pa je neophodno dopuniti podešavanje za 

MassTransit6. 

services.AddMassTransit(config => { 

    config.AddConsumer<BasketCheckoutConsumer>(); 

    config.UsingRabbitMq((ctx, cfg) => { 

      cfg.Host(Configuration["EventBusSettings:HostAddress"]); 

      cfg.ReceiveEndpoint(EventBusConstants.BasketCheckoutQueue, c =>  

      { 

        c.ConfigureConsumer<BasketCheckoutConsumer>(ctx); 

      });  

    }); 

  }); 

services.AddMassTransitHostedService(); 

Implementacija: 

• EventBusConsumers 

o BasketCheckoutConsumer.cs 

• Mapper 

o OrderingProfile.cs 

Dodati DI za AutoMapper i klasu BasketCheckoutConsumer u Startup.cs datoteci. 

 
6 Ovo ne znači da Ordering API ne može biti i proizvođač i pretplatnik, već samo ako je i pretplatnik, onda treba registrovati klase 
koje će obrađivati pretplate na odgovarajuće poruke . 
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6. Kontejnerizacija Basket API i Ordering API mikroservisa sa RabbitMQ kontekstom 

S obzirom da smo dodali novu projektnu referencu (EventBus.Messages) u ovim mikroservisima, potrebno je da 

ažuriramo Dockerfile datoteke kako bi se projekti ispravno izgradili. To je moguće uraditi ručno, ali bolje je da 

ostavimo Visual Studio alatu da to automatski uradi za nas. U oba projekta uraditi naredne korake:  

• Obrisati Dockerfile datoteku. 

• Desni klik na ime projekta > Add > Docker Support... 

• Target OS: Linux. 

Dodati naredne resurse u docker-compose.override.yml datoteku: 

services: 

  basket.api: 

    container_name: basket.api 

    environment: 

      - ASPNETCORE_ENVIRONMENT=Development 

      - "CacheSettings:ConnectionString=basketdb:6379" 

      - "GrpcSettings:DiscountUrl=http://discount.grpc" 

      - "EventBusSettings:HostAddress=amqp://guest:guest@rabbitmq:5672" 

    depends_on: 

      - basketdb 

      - discount.grpc 

      - rabbitmq 

    ports: 

      - "8001:80" 

 

  ordering.api: 

    container_name: ordering.api 

    environment: 

      - ASPNETCORE_ENVIRONMENT=Development 

      - "ConnectionStrings:OrderingConnectionString=Server=orderdb;Database=OrderDb;User 

Id=sa;Password=MATF12345678rs2"  

      - "EventBusSettings:HostAddress=amqp://guest:guest@rabbitmq:5672"  

    depends_on: 

        - orderdb 

        - rabbitmq 

    ports: 

        - "8004:80" 
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7. Mrežni prolazi 

Tema ovih časova je izgradnja mrežnog prolaza pomoću Ocelot sistema. 

Svaki mikroservis koji radi u produkciji ima svoj jedinstveni HTTP URI putem kojeg se može komunicirati sa njime od 

strane nekih klijentskih aplikacija. Ukoliko klijenti imaju informaciju o tim URI-jima, onda oni mogu direktno slati 

zahteve tim mikroservisima. 

Direktna klijent-mikroservisi komunikacija 

 
 

Međutim, ovde imamo nekoliko potencijalnih problema: 

• Ako za neki slučaj upotrebe klijentska aplikacija treba da kontaktira više mikroservisa, onda time dolazi u 

situaciju da pravi veliki broj HTTP poziva. Takođe, klijentska aplikacija mora da „agregira“ rezultate od tih 

mikroservisa, čime se uvećava njena složenost. U idealnom scenariju, ovakve „agregacije“ rezultata bi 

trebalo da se rade na serverskoj strani jer su joj dostupni efikasniji protokoli za komunikaciju (na primer, 

gRPC). 

• U ovakvom modelu, neke stvari se moraju implementirati na svakom mikroservisu, kao što je  bezbednost 

mikroservisa. Na primer, ako neki klijent pošalje zahtev mikroservisima Basket, Ordering i Catalog  za 

izvršavanje nekog slučaja upotrebe, svi ti mikroservisi moraju prvo da identifikuju koji korisnik je u pitanju 

(autentifikacija), a potom da provere da li taj korisnik ima neophodne privilegije da izvrši odgovarajuću akciju 

(autorizacija). 

• Klijentske aplikacije ne mogu da koriste pogodne protokole za komunikaciju sa servisima, kao što su AMQP, 

već se ovakvi zahtevi moraju interno transformisati. 

• Ne postoji način za definisanje „fasada“ za specifične tipove aplikacija, kao što su mobilne aplikacije. 

Svi ovi problemi se mogu rešiti uvođenjem mrežnog prolaza (eng. gateway). 

Obrazac „mrežni prolaz“ 
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Često se koristi i više mrežnih prolaza za različite vrste aplikacija. Tada govorimo o BFF (eng. Backend For Frontend) 

obrascu. Ideja je da za svaku vrstu aplikacija definišemo različite API-je kojima oni pristupaju. Na primer, ako je 

klijentska aplikacija uprošćena verzija veb aplikacije, onda nema razloga da ona pristupa svim API-jima koji su 

dostupni veb aplikaciji. 

Obrazac „BFF“ 

 
 

1. Kreiranje Ocelot mikroservisa 

Kreiramo novi projekat: 

• Desni klik na naziv Solution-a  

• Add > New Solution Folder 

• Imenujemo direktorijum „ApiGateways“ 

• Desni klik na „ApiGateways“ 

• Location: Add > New Project 

• ASP.NET Core Empty 

• Popuniti neophodnim podacima: 

o Project name: SPAGateway 

o Location: LOKACIJA_LOKALNOG_REPOZITORIJUMA\ApiGateways\ 

• Next 

• Odabrati opciju .NET 5.0 (Current) 

• Create 

Instalirati naredne NuGet pakete: 

• Ocelot 

Sada je potrebno izmeniti podešavanja: 

• Desni klik na naziv projekta > Properties 

• Podesiti kao na slici pored.  

U datoteci Startup.cs dodati DI za Ocelot: 

services.AddOcelot(); 

U istoj datoteci u Configure metodi dodati pipeline za Ocelot middleware: 

await app.UseOcelot(); 
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2. Razvoj Ocelot mrežnog prolaza 

Podešavanje Ocelot-a se vrši pomoću JSON datoteka. Da bismo napravili preslikavanje ruta javnog API-ja na rute ka 

mikroservisima, potrebno je da napravimo JSON datoteku koja će opisivati ova preslikavanja. 

Kreiramo 3 ovakve JSON datoteke: 

• ocelot.json koja definiše opšta pravila. 

• ocelot.Local.json koja definiše pravila kada pokrećemo aplikacije lokalno.  

• ocelot.Development.json koja definiše pravila kada pokrećemo aplikacije iz Docker-a. 

Na osnovu tipa okruženja (ASPNETCORE_ENVIRONMENT), sistem treba da učita odgovarajuću datoteku. U datoteci 

Program.cs dodajemo konfiguraciju za učitavanje JSON datoteke: 

Host.CreateDefaultBuilder(args) 

  .ConfigureAppConfiguration((hostingContext, config) => 

  { 

    config.AddJsonFile($"ocelot.{hostingContext.HostingEnvironment.EnvironmentName}.json", true, true); 

  }) 

  ... 

Ocelot JSON datoteka se obično sastoji od dva svojstva: Routes i GlobalConfiguration. Svojstvo Routes predstavlja 

niz koji sadrži definicije preslikavanja ruta, a svojstvo GlobalConfiguration predstavlja objekat koji sadrži podešavanja 

koja važe za sve rute. 

Svako preslikavanje ruta se definiše jednim JSON objektom  koji se nalazi u nizu Routes. Ovi objekti imaju nekoliko 

vrsta svojstava, od kojih su najvažniji oni koji počinju rečima „Downstream“ i „Upstream“. Prva svojstva se odnose na 

unutrašnje putanje ka mikroservisima, a druga svojstva se odnose na putanje koje će biti vidljive klijentskim 

aplikacijama. Svako preslikavanje ruta mora imati i „Downstream“ i „Upstream“ svojstva. 

U narednoj tabeli je dat primer jednog preslikavanja skupa ruta iz Catalog API-ja: 

U lokalnom okruženju: U Docker okruženju: 

{ 
  "DownstreamPathTemplate": "/api/v1/Catalog", 
  "DownstreamScheme": "http", 
  "DownstreamHostAndPorts": [ 
    { 
      "Host": "localhost", 
      "Port": "5000" 
    } 
  ], 
  "UpstreamPathTemplate": "/Catalog", 
  "UpstreamHttpMethod": [ "GET", "POST", "PUT" ] 
} 

{ 
  "DownstreamPathTemplate": "/api/v1/Catalog", 
  "DownstreamScheme": "http", 
  "DownstreamHostAndPorts": [ 
    { 
      "Host": "catalog.api", 
      "Port": "80" 
    } 
  ], 
  "UpstreamPathTemplate": "/Catalog", 
  "UpstreamHttpMethod": [ "GET", "POST", "PUT" ] 
} 

 

Objekat GlobalConfiguration obavezno ima svojstvo BaseUrl koji predstavlja URI preko kojeg će klijenti kontaktirati 

Ocelot radi. U našem slučaju, to će biti http://localhost:5010, kao što smo definisali u podešavanjima projekta iznad.  

Ocelot podržava neke korisne opcije, kao što su: 

• Limitiranje zahteva: https://ocelot.readthedocs.io/en/latest/features/ratelimiting.html  

• Keširanje: https://ocelot.readthedocs.io/en/latest/features/caching.html  

• Agregiranje zahteva: https://ocelot.readthedocs.io/en/latest/features/requestaggregation.html  

• Autentikacija: https://ocelot.readthedocs.io/en/latest/features/authentication.html  

http://localhost:5010/
https://ocelot.readthedocs.io/en/latest/features/ratelimiting.html
https://ocelot.readthedocs.io/en/latest/features/caching.html
https://ocelot.readthedocs.io/en/latest/features/requestaggregation.html
https://ocelot.readthedocs.io/en/latest/features/authentication.html
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• Autorizacija: https://ocelot.readthedocs.io/en/latest/features/authorization.html  

3. Kontejnerizacija Ocelot mikroservisa  

Dodavanje podrške za Docker Compose projektu: 

• Desni klik na naziv projekta 

• Add > Container Orchestrator Support 

• Docker Compose 

• Ok 

• Linux 

• Ok 

Dodati naredne resurse u docker-compose.override.yml datoteku: 

services: 

  ocelotapigateway: 

    container_name: ocelotapigateway 

    environment: 

      - ASPNETCORE_ENVIRONMENT=Development 

    depends_on: 

      - catalog.api 

      - basket.api 

      - discount.api 

      - ordering.api 

    ports: 

      - "8010:80" 

 

 

  

https://ocelot.readthedocs.io/en/latest/features/authorization.html
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8. Bezbednost mikroservisnih aplikacija 

Tema ovih časova jeste uvođenje sigurnosnih mehanizama u mikroservisne aplikacije.  

Do sada smo naučili kako da razvijamo mikroservisne aplikacije. Trenutno stanje naše aplikacije je takvo da svako 

može da pošalje bilo koji dostupni HTTP zahtev našim API-jima. Takve API-je nazivamo javnim. Međutim, često ne 

želimo da proizvoljni klijenti, aplikacije ili neki drugi sistemi (u daljem tekstu, akteri) imaju javni pristup našim API-

jima. Zbog toga je neophodno da uvedemo neke sigurnosne mehanizme: 

• Autentifikacija (eng. authentication) predstavlja identifikovanje aktera i verifikaciju tog identiteta. 

Identifikovanje se može vršiti na nekoliko načina: 

o Identifikovanje na osnovu saznanja (knowledge-based authentication) 

▪ Lozinka, PIN, ... 

o Identifikovanje na osnovu vlasništva (ownership-based authentication) 

▪ Sertifikat, kartica, USB, ... 

o Identifikovanje na osnovu nasleđa (inherence-based authentication) 

▪ Otisak prsta, DNA sekvenca, ... 

Nekada sistemi koriste više od jedne vrste autentifikacije i to su primeri dvofaktornih sistema autentifikacije 

(tzv. 2FA sistemi). Na primer, nakon uspešnog prijavljivanja pomoću korisničkog imena i lozinke (saznanje), 

aplikacija zahteva od korisnika da potvrdi prijavljivanje na mobilnom uređaju  otiskom prsta (nasleđe). 

• Autorizacija (eng. authorization) predstavlja proces odlučivanja da li je identifikovanom akteru dopušteno da 

izvrši odgovarajuću akciju u sistemu. Postoji nekoliko načina za izvršavanje autorizacije : 

o Jedan od najpopularnijih jeste obezbeđivanje bezbednosti na osnovu uloga (eng. role-based security). 

U ovom modelu, prava za pristup se ne daju konkretnim korisnicima, već apstrakcijama koje se 

nazivaju uloge (eng. role). Pojedinačnim korisnicima se onda pridružuju uloge, preko kojih oni 

dobijaju pristup. 

o Drugi način jeste obezbeđivanje bezbednosti na osnovu tvrdnji (eng. claim-based security). Osnovni 

aspekt ovog pristupa jeste skup tvrdnji (eng. claim). Jedna tvrdnja predstavlja jednu pretpostavku 

koju entitet ima o sebi. Na primer, neki korisnik može imati pridružene naredne tvrdnje: 

▪ Ime ovog korisnika je Pera. 

▪ Perina adresa elektronske pošte je pera.peric@rs2.matf.bg.ac.rs.  

▪ Pera ima 25 godina. 

▪ Pera može da briše korisnike. 

Kao što vidimo, u ovom modelu korisnik sistemu daje na raspolaganju skup tvrdnji, a ne uloge. Ovaj 

skup tvrdnji se prosleđuje kao deo sigurnosnog tokena (eng. security token).  

Naravno, sistem mora da zna da odredi da li može da veruje nekom skupu tvrdnji. Ovo poverenje se 

obično implementira posredstvom posebne aplikacije u koju naš sistem ima poverenje. Takva 

aplikacija često i sama izdaje skupove tvrdnji i vrši proveru validnosti nekog skupa tvrdnji.  Ako ona 

utvrdi verodostojnost skupa tvrdnji, onda i naš sistem ima poverenje u taj skup tvrdnji. Ovakva 

aplikacija se naziva izdavač ovlašćenja (eng. issuing authority, skr. IA). Deo IA koji prihvata zahteve za 

tokenima se naziva servis bezbednostih tokena (eng. security token service, skr. STS). Ako se 

izdavanje tokena prepusti nekoj drugoj aplikaciji umesto IA, onda se ta aplikacija naziva provajder 

identiteta (eng. identity provider, skr. IdP). U tom slučaju, IdP validira kredencijale aktera i 

iskomunicira validnost kredencijala nazad to STS. Ako su kredencijali validni, STS izdaje token sa 

tvrdnjama. Akter onda može da prosledi dobijeni token našem sistemu koji validira token, izdvoji 

tvrdnje iz tokena, prepozna identitet na osnovu tvrdnji i nivo pristupa sistemu na osnovu tih tvrdnji.  

Tok koji ćemo koristiti je prikazan na slici ispod. 
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1. Podešavanje IdentityServer mikroservisa i osnovna implementacija 

Kreirajmo novi ASP.NET Core Web Api projekat (.NET 5.0) naziva IdentityServer na putanji 

LOKACIJA_LOKALNOG_REPOZITORIJUMA\Webstore\Security i postavimo ga da se pokreće na adresi 

http://localhost:4000. Instalirajmo naredne NuGet pakete: 

• Microsoft.AspNetCore.Identity.EntityFrameworkCore 

• Microsoft.EntityFrameworkCore.Design 

• Microsoft.EntityFrameworkCore.SqlServer 

• AutoMapper.Extensions.Microsoft.DependencyInjection 

• Microsoft.AspNetCore.Authentication.JwtBearer 

S obzirom da ćemo i u ovom mikroservisu koristiti SQL Server, ažuriramo docker-compose.yml i docker-

compose.override.yml datoteke tako da se mikroservis orderdb preimenuje u mssql. Naredne slike prikazuju 

izmene. 

Datoteka docker-compose.yml. 

 

Datoteka docker-compose.override.yml. 
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Pređimo na implementaciju mikroservisa: 

• Entities 

o User.cs 

• Data 

o ApplicationContext.cs 

• Extensions 

o IdentityExtensions.cs 

Zatim ažuriramo Startup.cs kako bismo dodali pozive kreiranih ekstenzija u ConfigureServices metodu: 

// Services relevant to Identity 

services.AddAuthentication(); 

 

services.ConfigurePersistence(Configuration); 

services.ConfigureIdentity(); 

Dodatno, u metodu Configure dodajemo naredne pozive7: 

app.useAuthentication(); 

app.useAuthorization(); 

Sada izvršimo naredne naredbe kako bismo dodali migraciju za dodavanje Identity tabela: 

Add-Migration CreatingIdentityTables 

Update-Database 

Ukoliko želimo da vidimo kreirane tabele, možemo se povezati na SQL Server iz Visual Studio alata:  

• Tools > Connect to Database... 

• Uneti podatke kao na slici ispod (levo). 

• Klikom na dugme Test Connection možemo isprobati da li je konekcija uspešna.  

• OK. 

U SQL Server Object Explorer-u bi trebalo da se prikažu tabele kao na slici ispod (desno).  

    

 
7 Veoma je važno da ovi pozivi budu u ovom redosledu i da se nalaze između poziva metoda UseRouting i UseEndpoints. 
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Konačno, podesimo i dve uloge koje naši korisnici mogu da imaju – administrator i kupac: 

• Data 

o Configuration 

▪ RoleConfiguration.cs 

Dodajemo preopterećenje metoda OnModelCreating u klasi ApplicationContext koje će uključiti implementiranu 

konfiguraciju za uloge. Kreirajmo novu migraciju: 

Add-Migration AddedRolesToDb 

Update-Database 

Možemo primetiti da tabela dbo.AspNetRoles sada ima dve nove uloge: 

 

2. Implementacija registracije korisnika 

Implementiramo novi kontroler koji ćemo koristiti za potrebe autentifikacije . Dodajemo dva metoda - jedan za 

registraciju kupaca, a drugi za registraciju administratora. 

• DTOs 

o NewUserDto.cs 

• Mapper 

o IdentityProfile.cs  

• Controllers 

o AuthenticationController.cs 

o AuthenticationControllerBase.cs 

Dodajemo metod ConfigureMiscellaneousServices u IdentityExtensions klasi i pozivamo ga u Startup klasi. 

Testirajmo implementirane metode. 

{ 

    "firstname": "Pera", 

    "lastname": "Peric", 

    "username": "rs2", 

    "password": "test1234", 

    "email": "razvoj.softvera.matf@gmail.com", 

    "phonenumber": "123-456789" 

} 
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Dodajmo i jednog korisnika koji nije administrator, već kupac: 

{ 

    "firstname": "Ana", 

    "lastname": "Peric", 

    "username": "anaperic", 

    "password": "test1234", 

    "email": "ana.peric@matf.rs", 

    "phonenumber": "123-456789" 

} 

3. Izdavanje JWT tokena 

Dodajemo naredna podešavanja u appsetting.development.json datoteci: 

  "JwtSettings": { 

    "validIssuer": "Webstore Identity", 

    "validAudience": "Webstore", 

    "secretKey": "MyVerySecretMessage" 

  } 

Zatim dodajemo novi metod ConfigureJWT u IdentityExtensions klasi i pozivamo ga u ConfigureServices metodu. 

Redosled implementacije: 

• DTOs 

o UserCredentialsDto.cs 

• Services 

o IAuthenticationService.cs 

o AuthenticationService.cs 

Dodajemo DI za napisani servis: 

public static IServiceCollection ConfigureMiscellaneousServices(this IServiceCollection services) 

{ 

    ... 

    // Other 

    services.AddScoped<IAuthenticationService, AuthenticationService>(); 

    ... 

} 

Dodajemo metod Login za prijavljivanje u AuthenticationController klasi. Sada možemo da testiramo 

implementaciju:  

 



47 
 

 

Na adresi https://jwt.io možemo dekodirati sadržaj JWT tokena: 

 

Kao što vidimo, generisani token sadrži sve informacije koje smo prosledili prilikom njegovog kreiranja. 

4. Dodavanje autorizacije 

Kako bismo testirali dobijeni token, mogli bismo da kreiramo novi kontroler koji će biti dostupan samo 

administratorima sistema. U tu svrhu, dodajmo novi API za upravljanje korisnicima. 

• DTOs 

o UserDetails.cs 

• Controllers 

o UserController.cs 

Napomenimo da je Authorize atribut moguće koristiti i na nivou pojedinačnih ruta.  

Testirajmo zahtev za dohvatanje detalja o svim korisnicima: 

https://jwt.io/
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Dobijamo odgovor 401 zato što se nismo autentifikovali. Da bismo to uradili u alatu Postman, potrebno je da 

dodamo JWT token kao Bearer shemu u Auth pogledu: 

 

S obzirom da svi metodi nad ovim kontrolerom zahtevaju da autentifikovani korisnik  ima ulogu administratora, ako 

probamo da izvršimo isti zahtev, ali koristeći JWT nekog kupca, onda ćemo dobiti statusni kod 403 kao odgovor:  

 

Isto ovo dodajemo za RegisterAdministrator akciju, kako bi samo administratori mogli da kreiraju druge 

administratore. 

5. Kontejnerizacija IdentityServer mikroservisa 

Dodajmo podršku za orkestrizaciju implementiranom projektu. Izmeniti docker-compose.override.yml datoteku: 

  identityserver: 

    container_name: identityserver 

    environment: 

      - ASPNETCORE_ENVIRONMENT=Development 
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      - "ConnectionStrings:IdentityConnectionString=Server=mssql;Database=IdentityDb;User 

Id=sa;Password=MATF12345678rs2" 

    depends_on: 

      - mssql 

    ports: 

      - "4000:80" 

6. Zaštita drugih mikroservisa 

U svakom mikroservisu u kojem želimo da primenimo JWT Bearer strategiju kako bismo zaštitili akcije, potrebno je 

da uradimo naredne korake: 

• Instalirati NuGet paket Microsoft.AspNetCore.Authentication.JwtBearer 

• Specifikovati koje rute zahtevaju autorizaciju (i, eventualno, koju ulogu): 

 

namespace Basket.API.Controllers 

{ 

    [Authorize(Roles = "Buyer")] 

    [ApiController] 

    [Route("api/v1/[controller]")] 

    public class BasketController : ControllerBase 

    ... 

 

• Ažurirati datoteku appsettings.development.json tako da sadrži neophodne JWT informacije: 

   

  "JwtSettings": { 

    "validIssuer": "Webstore Identity", 

    "validAudience": "Webstore", 

    "secretKey": "MyVerySecretMessage" 

  } 

 

• Ažurirati Startup klasu tako što se u ConfigureServices metodu doda naredni kod: 

 

  // JWT Security 

  var jwtSettings = Configuration.GetSection("JwtSettings"); 

  var secretKey = jwtSettings.GetSection("secretKey").Value; 

   

  services.AddAuthentication(options => 

  { 

      options.DefaultAuthenticateScheme = JwtBearerDefaults.AuthenticationScheme; 

      options.DefaultChallengeScheme = JwtBearerDefaults.AuthenticationScheme; 

  }) 

      .AddJwtBearer(options => 

      { 

          options.TokenValidationParameters = new TokenValidationParameters 

          { 

              ValidateIssuer = true, 

              ValidateAudience = true, 

              ValidateLifetime = true, 

              ValidateIssuerSigningKey = true, 
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              ValidIssuer = jwtSettings.GetSection("validIssuer").Value, 

              ValidAudience = jwtSettings.GetSection("validAudience").Value, 

              IssuerSigningKey = new SymmetricSecurityKey(Encoding.UTF8.GetBytes(secretKey)) 

          }; 

      }); 

 

a u Configure metodu doda naredni kod: 

 

  app.UseAuthentication(); 

  app.UseAuthorization(); 

Dodatna zaštita korišćenjem tvrdnji 

Obezbeđivanje zaštite korišćenjem uloga nam pomaže da sprečimo čitavu klasu korisnika  da pristupi akcijama koje 

im nisu dostupne u sistemu. Međutim, ovo nam često nije dovoljno. Na primer, u BasketController klasi smo rekli da 

samo korisnici koji imaju ulogu „kupac“ mogu da izvršavaju akcije definisane u tom kontroleru, kao što je dohvatanje 

sadržaja korpe. Međutim, ne postoji provera da li je kupac koji dohvata korpu isti onaj kupac čija se korpa dohvata. 

Drugim rečima, jedan kupac može dohvatiti korpu za nekog drugog kupca, sve dok zna njegovo korisničko ime.  

Rešenje se nalazi u implementiranju zaštite korišćenjem tvrdnji. Sve klase koje naslede ControllerBase imaju na 

raspolaganju objekat User koji sadrži informacije o autentifikovanim korisnicima. Pomoću ovog objekta možemo 

dohvatiti informacije o tvrdnjama, na primer: 

public async Task<ActionResult<ShoppingCart>> GetBasket(string username) 

{ 

    if (User.FindFirstValue(ClaimTypes.Name) != username) 

    { 

        return Forbid(); 

    } 

 

    var basket = await _repository.GetBasket(username); 

    return Ok(basket ?? new ShoppingCart(username)); 

} 

Ovako se možemo obezbediti da kupci mogu da dohvataju  korpu samo za sebe. Zapravo, uvođenjem autentifikacije i 

koncepta tvrdnji, moguće je promeniti API tako da više ne zahteva korišćenje korisničkog imena:  

public async Task<ActionResult<ShoppingCart>> GetBasket() 

{ 

    var username = User.FindFirstValue(ClaimTypes.Name); 

    if (username == null) // Vrednost za username će biti null ako ne postoji tvrdnja ClaimTypes.Name. 

    { 

        return Forbid(); 

    } 

 

    var basket = await _repository.GetBasket(username); 

    return Ok(basket ?? new ShoppingCart(username)); 

} 

7. Refresh tokeni 

Tokeni koje smo do sada izdvajali se nazivaju još i access tokeni zato što se koriste za pristup akcijama u sistemu. 

Svako ko ima validan access token može izvršavati dozvoljene akcije. Kada token postane nevalidan, korisnici moraju 

da se ponovo autentifikuju kako bi dobili novi token. U ovom toku imamo neke probleme: 
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• Ako je vreme za koje token postaje nevalidan premalo (na primer, 15 minuta), onda korisnici moraju često da 

se autentifikuju. Korisnicima je prečesta autentifikacija veoma naporna. 

• Ako je vreme za koje token postaje nevalidan preveliko (na primer, mesec dana), onda korisnici ne moraju 

toliko često da se autentifikuju. Međutim, sada rizikujemo da neko treće lice dobije pristup našem sistemu 

ukoliko (na neki način) sazna za taj token. 

Drugi problem se može rešiti u postojećem sistemu tako što se za svakog korisnika trajno čuvaju svi izdati access 

tokeni (na primer, u bazi podataka). Zatim, prilikom korišćenja nekog access tokena, sistem treba da proveri da li je 

access token i dalje povezan sa korisnikom (tj. da li se nalazi u bazi podataka). U slučaju da se otkrije da je došlo do 

zloupotrebe access tokena, jednostavno se mogu obrisati svi access tokeni za datog korisnika, čime se poništavaju svi 

access tokeni. Korisnik onda mora ponovo da se autentifikuje kako bi pristupio sistemu, ali dalja zloupotreba 

poništenih access tokena nije moguća. Očigledan, a znajačan, problem sa ovim pristupom jeste taj da svaki poziv ka 

API-ju našeg sistema zahteva pretragu access tokena u bazi podataka. Ovime se značajno usporava rad sistema. 

Rešenje se sastoji u uvođenju nove vrste tokena i promeni autorizacionog toka. Refresh tokeni predstavljaju 

kredencijale koji se koriste za izdavanje novih access tokena. Kada access token istekne, umesto da zahtevamo od 

korisnika da se autentifikuje pomoću svojih kredencijala, sistem može iskoristiti (validan) refresh token kako bi dobio 

novi access token od komponente za autentifikaciju. Naravno, ako je refresh token nevalidan, onda sistem zahteva 

ponovnu autentifikaciju od korisnika. Međutim,  na ovaj način možemo iskoristiti kratkotrajne access tokene, a po 

pravilu su refresh tokeni dužeg trajanja8. 

Tok koji se koristi u slučaju korišćenja access i refresh tokena je prikazan na slici ispod. 

 

Za početak, ažurirajmo appsettings.development.json datoteku da obuhvati podešavanje za isticanje refresh tokena: 

  "RefreshTokenExpires": 30 

Dopunimo User model tako da sadrži informacije o svim izdatim refresh tokenima i njihovim vremenskim 

odrednicama za isticanje: 

• Entities 

o RefreshToken.cs 

o User.cs 

• Data 

o Configurations 

 
8 Ne postoje tvrda pravila koliko dugo neki token treba da živi, ali access tokeni ne bi trebalo da važe duže od 15 minuta. U 
slučaju da treće lice sazna za ovakav token, on će imati pristup sistemu najduže 15 minuta, nakon čega token postaje nevalidan. 
Ovo je uglavnom prihvatljivo. Dužina trajanja refresh tokena se uglavnom određuje time koliko dugo že limo da dozvolimo 
korisnicima da koriste sistem bez da moraju da se autentifikuju ponovo. 
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▪ UserConfiguration.cs 

o ApplicationContext.cs 

Sada nam je potrebna nova migracija: 

Add-Migration AddedRefreshTokensToUser 

Update-Database 

Možemo primetiti novu tabelu u SQL Server Object Explorer pogledu: 

 

Sada prelazimo na implementaciju metoda za izdavanje nove vrste tokena. Usput ćemo refaktorisati servis za 

autentifikaciju: 

• DTOs 

o AuthenticationModel.cs 

o RefreshTokenModel.cs 

• Services 

o IAuthenticationService.cs 

o AuthenticationService.cs 

• Controllers 

o AuthenticationController.cs 

Ako sada dva puta pozovemo Login API za istog korisnika, dobićemo naredno stanje u dbo.RefreshTokens tabeli: 

 

Naravno, ovaj API treba da vrati podatke o oba tokena: 
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Ostalo nam je još da proverimo da li i Logout API radi kako je očekivano: 

 

Stanje u bazi: 

 

Testirajmo sada Refresh API: 

 

Stanje u bazi: 
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9. Jednostranične klijentske aplikacije 

Tema ovih časova je razvoj jednostraničnih aplikacija pomoću Angular 12. 

Literatura: 

• Angular dokumentacija: https://angular.io/docs  

• Odlomci iz skripte „Programiranje za veb“: https://www.nikolaajzenhamer.rs/assets/pdf/pzv.pdf#page=241  

Angular video lekcije: 

• Reaktivna paradigma u JS i biblioteka RxJS: https://youtu.be/3QC45tpjwRk 

• Komponente: https://youtu.be/C-G7wzMEbE4  

• Ugrađene direktive, razmena podataka između komponenti i životni ciklus komponenti: 

https://youtu.be/p1H4Bptc4UM  

• Servisi, rutiranje na klijentu, formulari i filteri: https://youtu.be/N2e-7FgbCVY  

• HTTP komunikacija: https://youtu.be/IQs2HKtVWa0  

 

https://angular.io/docs
https://www.nikolaajzenhamer.rs/assets/pdf/pzv.pdf#page=241
https://youtu.be/3QC45tpjwRk
https://youtu.be/C-G7wzMEbE4
https://youtu.be/p1H4Bptc4UM
https://youtu.be/N2e-7FgbCVY
https://youtu.be/IQs2HKtVWa0

